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Введение 

В пособии представлены пошаговые подробные описания постановки и 

решения некоторых задач механики. Рассмотрены вопросы применения 

одномерных элементов в ANSYS Mechanical APDL, решена связанная задача 

о движении вязкой несжимаемой жидкости по трубе с упругими стенками, 

которая находит свое применение в биомеханике кровообращения [1, 4]. 

Описан пример нагружения в два шага, которое позволяет моделировать 

свободные колебания балки. 

Приведены команды для активирования режима FSI в ANSYS 

Mechanical APDL, которые сегодня уже практически не встретишь в 

литературе.  

В рассматриваемых в пособии задачах геометрические модели 

строились или в CAD редакторе ANSYS, или импортировались из систем 

автоматизированного проектирования типа SolidWorks [2, 3]. 

Некоторые задачи, например, задача об НДС в коньковом соединении 

балок, имеет прикладное значение.  

Проблема выбора параболического или прямоугольного профиля при 

задании скорости на входе в сосуд в задачах биомеханики [5] является 

актуальной. Зачастую ответ на этот вопрос принимается без обсуждения. В 

данном пособии рассмотрен сравнительный анализ решений задачи о 

течении крови по сосуду с параболическим и прямоугольным профилем 

скорости на входе. 

Пособие ориентировано на читателей, имеющих базовый опыт решения 

задач механики в ANSYS.  
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1 Решение задачи о плоском изгибе консольной балки 

Покажем решение задачи о плоском изгибе консольной балки в 

программном продукте ANSYS в трех постановках: одномерной, двумерной 

и трехмерной. Приведенное решение проведено в Mechanical APDL. 

1.1 Решение задачи в одномерной постановке 

Выберем тип решаемой задачи : Preferences → structural (рисунок 1.1.1). 

 

Рисунок 1.1.1– Тип решаемой задачи. 

После этого выберем тип элемента из библиотеки элементов: 

Preprocessor → Element Type → Add\Edit\Delete (рисунок 1.1.2). Выберем 

элемент, который соответствует балочной постановке. 

 

Рисунок 1.1.2– Тип элемента для одномерной постановки. 

После этого зададим физико-механические свойства элемента: модуль 

Юнга, коэффициент Пуассона и плотность (2е11 Па, 0.33 и 7800 кг/м
3
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соответственно): Preprocessor → Material Props → Material Models 

(рисунок 1.1.3). 

 

Рисунок 1.1.3 – Задание свойств материала. 

Для одномерной постановки решения задачи о чистом изгибе балки 

необходимо задать ширину и толщину балки, а так же форму поперечного 

сечения. Для этого нужно выбрать пункт Preprocessor → Sections → Beam → 

Common Sections (рисунок 1.1.4). 

 

Рисунок 1.1.4 – Задание геометрических размеров сечения балки. 

Перейдем к построению модели балки. Зададим точки 

(рисунок 1.1.5 (а, б)): Preprocessor → Modeling → Create → Keypoints → 

Active CS. 

 

 

Рисунок 1.1.5 –Задание крайних точек балки. 
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После чего построим по точкам линию: Preprocessor → Modeling → 

Create → Lines → Straight Line. 

Создадим вычислительную сетку: Preprocessor → Meshing → Mesh 

Tools. В окне Mesh зададим Line. В поле Global установим значение для 

элемента 0.2, после чего нажмем Mesh.  

Поставим граничные условия: Preprocessor → Loads→ Define Loads → 

Apply → Structural → Displacement → On KP (рисунок 1.1.6). Зададим силу в 

1000 Н, действующую на консольный конец балки Preprocessor → Loads→ 

Define Loads → Apply → Structural → Force\Moments → On KP 

(рисунок 1.1.7). 

 

Рисунок 1.1.6 – Задание жесткой заделки. 

 

Рисунок 1.1.7 – Задание действующей на край балки силы. 

Если все сделано правильно, балка после наложения сетки и задания 

граничных условий будет выглядеть, как на рисунке 1.1.8. 

 

Рисунок 1.1.8 – Вычислительная сетка и граничные условия. 

Проведем расчет: Solution → Solve → Current LS. 
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Считаем полученные результаты General Postproc → Read results → 

Last set, после чего выведем результаты на экран: General Postproc → Plot 

results → Deformed Shape (рисунок 1.1.9). 

 

Рисунок 1.1.9 – Результат решения задачи в одномерной постановке – деформированная 

геометрия балки. 

Согласно решению задачи о чистом изгибе в одномерной постановке, 

перемещение в крайней точке консольной балки составило 0.202 мм. 

 

1.2 Решение задачи в двумерной постановке 

Тип решаемой задачи останется таким же, как и в предыдущем случае. 

Но тип элементы изменится. Выберем тип элемента из библиотеки 

элементов: Preprocessor → Element Type → Add\Edit\Delete (рисунок 1.2.1).  

 

Рисунок 1.2.1 - Задание типа элемента в двумерной постановке. 

Зададим физико-механические свойства материала так же, как в 

одномерном случае. Мы выбрали двумерную постановку в оболочках, 

следовательно, необходимо задать толщину построенной геометрии: 

Preprocessor → Sections → Shell → Lay-Up → Add\Edit (рисунок 1.2.2.). 
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Рисунок 1.2.2 – Задание толщины геометрии. 

Построим геометрию Preprocessor → Modeling → Create → Create → 

Rectangle → By 2 Corners (рисунок 1.2.3). 

Создадим сетку таким же образом, как в прошлый раз: в окне Global 

снова зададим 0.2. Чтобы сетка была регулярной, поставим параметр Quad, 

Mapped. 

 

Рисунок 1.2.3 – Создание прямоугольной геометрии. 

Зададим граничные условия. Для задания жесткой заделки: Preprocessor 

→ Loads→ Define Loads → Apply → Structural → Displacement → By Line. 

Зададим силу, действующую на консольный конец балки Preprocessor → 

Loads→ Define Loads → Apply → Structural → Force\Moments → On Nodes. 

Задавая силу, воспользуемся опцией «Box», чтобы выделить все узлы в 

торцевой части структуры. Выберем пункт «On Nodes» вместо «On KP» в 

связи с тем, что Nodes – количество узлов сетки, а KP только точки в узлах 

прямоугольника. Чтобы величина приложенной нагрузки совпадала с 

величиной нагрузки из предыдущего случая, поделим суммарную нагрузку 

на количество узлов, получая по -166.67 Н на каждый узел.  
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Если все сделано правильно, балка после наложения сетки и задания 

граничных условий будет выглядеть, как на рисунке 1.2.4. 

Рисунок 1.2.4 – Вычислительная сетка и граничные условия. 

Проведем расчет: Solution → Solve → Current LS. Считаем полученные 

результаты: General Postproc → Read results → Last set, после чего выведем 

результаты на экран: General Postproc → Plot results → Deformed Shape 

(рисунок 1.2.5). 

 

Рисунок 1.2.5 – Результаты решения задачи в двумерной постановке – деформированная 

геометрия балки. 

По результатам решения (рисунок 1.2.5), перемещение крайней точки 

консольной балки составило 0.209 мм. 

1.3 Решение задачи в трехмерной постановке 

Тип решаемой задачи останется таким же, как и в предыдущих случаях. 

Выберем тип элемента из библиотеки элементов: Preprocessor → Element 

Type → Add\Edit\Delete (рисунок 1.3.1).  

 

Рисунок 1.3.1- Задание типа элемента в трехмерной постановке. 
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Зададим физико-механические свойства материала так же, как в 

предыдущем случае. Построим геометрию: Preprocessor → Modeling → 

Create → Volume → Block → By 2 Corners & Z (рисунок 1.3.2). 

 

Рисунок 1.3.2 – Создание параллелепипеда. 

Создадим сетку таким же образом, как в предыдущем случае. Чтобы 

сетка была регулярной, поставим параметр «Hex».  

Зададим граничные условия. Для задания жесткой заделки: Preprocessor 

→ Loads→ Define Loads → Apply → Structural → Displacement → By Area. 

Зададим силу, действующую на консольный конец балки Preprocessor → 

Loads→ Define Loads → Apply → Structural → Force\Moments → On Nodes. 

Задавая силу, воспользуемся опцией «Box», чтобы выделить все узлы в 

торцевой части структуры. Для того чтобы величина приложенной нагрузки 

совпадала с величиной нагрузки из предыдущих пунктов, поделим 

суммарную нагрузку на количество узлов (36), получая по -27.7 Н на каждый 

узел.  

Если все сделано правильно, балка после наложения сетки и задания 

граничных условий будет выглядеть, как на рисунке 1.3.3. 
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Рисунок 1.3.3 – Вычислительная сетка и граничные условия. 

Проведем расчет: Solution → Solve → Current LS. Считаем полученные 

результаты: General Postproc → Read results → Last set, после чего выведем 

результаты на экран: General Postproc → Plot results → Deformed Shape 

(рисунок 1.3.4, 1.3.5). 

 

Рисунок 1.3.4 – Решение задачи в трехмерной постановке – деформированная геометрия 

(изометрический вид). 
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Рисунок 1.3.5 –  Результат решение задачи в трехмерной постановке – деформированная 

геометрия (вид сбоку). 

Согласно решению задачи о чистом изгибе в трехмерной постановке, 

прогиб в крайней точке консольной балки составил 0.199 мм. 

Результаты решения задачи о чистом изгибе консольной балки для 

балок одинаковой геометрии и при одинаковой нагрузке совпали во всех трех 

постановках с погрешностью, не превышающей 5% (таблица 1.3.1). 

Таблица 1.3.1 – Сравнение результатов в перемещениях для разных постановок задачи. 

Тип решения задачи Максимальный прогиб, мм 

Одномерная постановка 0.202 

Двумерная постановка 0.209 

Трехмерная постановка 0.199 
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2 Расчёт НДС в коньковом соединении балок 

Построим трёхмерную модель конькового соединения балок 

двутаврового сечения в программном комплексе SolidWorks. На рисунке 2.1 

представлен чертёж модели конькового соединения с заданными нагрузками. 

 

Рисунок 2.1 – Чертёж конькового соединения балок. 

Для начала необходимо создать эскиз двутаврового сечения для балки 

55Б1. Геометрические размеры балки в соответствии с ГОСТ 26020-83: 

высота h = 543 мм, ширина полки b = 220 мм, толщина стенки s = 9.5 мм, 

толщина полки t = 13.5 мм, радиус сопряжения r = 24 мм (рисунок 2.2). 

 

Рисунок 2.2 – Размеры поперечного сечения балки. 

На рисунке 2.3 показан эскиз двутаврового сечения балки. 
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Рисунок 2.3 – Эскиз двутаврового сечения балки. 

Вытянув построенный эскиз (меню Вставка → Элементы → Вытянутая 

бобышка/основание), получим балку, изображённую на рисунке 2.4. 

 

Рисунок 2.4 – Модель балки. 

Для того чтобы построить модель конькового соединения, необходимо: 

1. Повернуть балку на 10° относительно горизонта (в соответствии с 

рисунком 2.1). 

2. Построить на торце пластину для соединения балок. 

3. Создать и закрепить болты и гайки в пластинах. 

Для поворота тела используется функция «Переместить/Копировать» 

(меню Вставка → Элементы), меню которой показано на рисунке 2.5. Здесь 

указывается тело, которое необходимо повернуть, и угол поворота 

относительно оси. 
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Рисунок 2.5 – Поворот тела. 

Для соединения балок необходимо отсечь часть балки на торце с 

помощью плоскости (рисунок 2.6) в функции «Пересечение» (меню Вставка 

→ Элементы), как показано на рисунке 2.7, под прямым углом к горизонту. 

 

Рисунок 2.6 – Вспомогательная плоскость для отсечения. 
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Рисунок 2.7 – Пересечение объектов. 

Построим на торце балки прямоугольную пластину, высота которой 

совпадает с высотой поперечного сечения балки, ширина равна ширине 

полки, а толщина совпадает с толщиной полки двутаврового сечения. На 

рисунке 2.8 изображён торец балки с пластиной. 

 

Рисунок 2.8 – Торец балки с пластиной. 
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Для соединения балок болтами необходимо создать отверстия под 

крепёж, это можно сделать в меню Элементы → Отверстие под крепёж. 

Параметры для создания отверстий и их расположение показаны на 

рисунке 2.9. 

 

Рисунок 2.9 – Параметры и расположение отверстий под болты. 

Создадим вторую балку отражением построенной модели относительно 

пластины на торце, это можно сделать в меню Элементы → Зеркальное 

отражение. 

Построенные балки соединяются шестью болтами М24, которые можно 

найти в библиотеке проектирования в разделе Toolbox→ ISO →Болты и 

винты → Болты и винты с шестигранными головками –  конструкционная 

сталь (рисунок 2.10), либо построить болт в соответствии с ГОСТ 7798-70 

(рисунок 2.11). 

 

Рисунок 2.10 – Болт из библиотеки проектирования. 
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Рисунок 2.11 – Построенный болт. 

При поднесении болтов из библиотеки проектирования к построенным 

отверстиям, они автоматически закрепятся на пластине. Аналогично 

поступим с гайками. 

Окончательная трёхмерная твердотельная модель конькового 

соединения балок представлена на рисунках 2.12 и 2.13. 

 

Рисунок 2.12 – Модель двутаврового соединения балок. 

 

Рисунок 2.13 – Модель двутаврового соединения балок. 

Для моделирования нагружения балок будем использовать модуль 

Static Structural в среде ANSYS Workbench. На рисунке 2.14 изображена 

панель инструментов в ANSYS Workbench и модуль Static Structural. 
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Рисунок 2.14 – Панель инструментов и модуль Static Structural. 

В разделе Engineering Data задаются свойства материалов модели. 

Материал балок имеет следующие свойства: плотность (Density) 

ρ = 7850 кг/м
3
, модуль Юнга (Young’s Modulus) E = 2*10

5 
МПа, коэффициент 

Пуассона (Poisson’s Ratio) υ = 0.3, предел текучести (Tensile Yield Strength) 

σт = 325 МПа, укажем эти данные в Engineering Data, как показано на 

рисунке 2.15. 

 

Рисунок 2.15 – Engineering Data. 

Для приложения нагрузок в соответствии с рисунком 1 необходимо 

разделить построенную модель на части. Для этого импортируем 

построенную модель в формате .STEP в раздел Geometry щелчком правой 

кнопки мыши, выбрав во всплывающем меню Import geometry → Browse.Для 

редактирования модели перейдём во всплывающем меню в Edit geometry in 

Desing Modeler. В открывшемся окне нажмём на кнопку  и 
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приступим к педактированию модели. Для разделения балки необходимо 

создать плоскость, которой мы будем делить элемент. Для начала создадим 

плоскость на поверхности пластины, выделив эту поверхность и нажав на 

кнопку  или в меню Create → New Plane. Сместим данную плоскость на 

расстояние соответствующее чертежу, задав в графе Transform направлние 

смещения и расстояние в графе Value 1 (рисунок 2.16). 

 

Римунок 2.16 – Создание плоскости. 

Разделим балку созданной плоскостью, создав разрез в меню Create → 

Slice. В функции Slise необходимо выбрать тип разреза (Slice Type) Slice by 

plane (разрез плоскостью), выбрать плоскость (Base Plane) и элементы, 

которые нужно разделить (Slice Targets). Разделив каждую балку 

плоскостями, получим модель, изображённую на рисунке 2.17. 

 

Рисунок 2.17 – Модель конькового соединения балок в Workbench. 

Перейдём в раздел Model. Зададим материал элементов в ветке 

Geometry в графе Assignment (Material), выбрав добавленный в разделе 

Engineering Data материал Structural Steel 2, как показано на рисунке 2.18. 
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Рисунок 2.18 – Присвоение материала. 

В разделе Model также задаётся сетка (Mesh). Создадим разные методы 

разделения для различных элементов конструкции. Для всех тел, не 

входящих в соединение балок (рисунок 2.19), зададим размер элементов 0.05 

м, на верхних поверхностях балок (рисунок 2.20) 0.01 м и зададим метод 

MultiZone для элементов в соединении балок (рисунок 2.21). 

 

Рисунок 2.19 – Зоны задания размеров сетки. 

 

Рисунок 2.20 – Зоны задания размеров сетки. 
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Рисунок 2.21 – Зоны задания размеров сетки. 

На рисунке 2.22 представлена получившаяся сетка. 

 

 

 

Рисунок 2.22 – Конечно-элементная сетка. 

Зададим граничные условия (Fixed Support) в ветке Static Structural на 

внешних торцах балок. На линиях, разделяющих верхние поверхности балок, 

зададим силы P1=P2=…=P12=0.6 кН, P13=P14=6.1 кН, P15=P16=3.3 кН (рисунок 

2.23) и решим задачу. 
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Рисунок 2.23 – Приложенные силы. 

В результате моделирования нагружения балок получим значения 

эквивалентных напряжений (рисунки 2.24) и поле перемещений (рисунок 

2.25) для данной конструкции.  

 

Рисунок 2.24 – Распределение напряжений. 

 

Рисунок 2.27 – Поле перемещений. 
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Материал, из которого изготовлена конструкция, – сталь 09Г2С в 

соответствии с ГОСТ 19281-89. Модуль Юнга материала составляет 2*10
11

 

Па, коэффициент Пуассона 0.33. Рассчитанные напряжения, возникающие в 

конструкции при приложении нагрузок, сравнивались с пределом текучести 

стали 09Г2С в соответствии с ГОСТ 19281-89, который принимался равным 

180 МПа (наименьшее значение из ГОСТ 19281-89). 

Напряжения по Мизесу достигали значений до 1.5 МПа в болтах и до 

32 МПа в двутавре. Следовательно, при рассматриваемых нагрузках, запас 

прочности существенный. Шести болтов достаточно для надежного 

конькового соединения с существенным запасом прочности. 
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3 Решение связанной задачи гидродинамики 

В данной работе будет рассмотрена задача о течении жидкости в трубе 

с упругими стенками. Готовая модель трубы с жидкостью импортирована в 

расчетный комплекс ANSYS Workbench. 

Запускаем ANSYS Workbench. В Toolbox → Analysis System выбираем 

тип анализа, который будет использоваться. В нашем случае это Static 

Structural и Fluid Flow (CFX). Перетаскиваем их в поле проекта Project 

Schematic (рисунок 3.1). 

 

Рисунок 3.1 – Поле проекта. 

 

Устанавливаем связи между этими типами анализа, как показано на 

рисунке. Нажимаем левой кнопкой мыши на Geometry в Transient Structural, 

не отпуская, подводим курсор к Geometry в Fluid Flow. Аналогично для Setup 

(рисунок 3.2). 
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Рисунок 3.2 – Связь между модулями. 

Задаем параметры анализа для Static Structural. Нажимаем правой 

кнопкой мышки на Geometry →Import Geometry →Browse. Выбираем файл с 

геометрией. 

Далее заходим в Design Modeler (рисунок 3.3). 

 

Рисунок 3.3 – Редактирование геометрии. 

В дереве Design Modeler нажимаем Import → Generate (рисунок 3.4). 

 

Рисунок 3.4 – Генерирование модели. 
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Модель состоит из 2 твердотельных элементов. Переименовываем их 

для удобства. Жидкость назовем «Water», а трубу назовем «Pipe». Также 

меняем свойство модели Add Frozen на Add Material (рисунок 3.5). 

 

Рисунок 3.5 – Модель трубы. 

Выходим из Design Modeler. По умолчанию в Engineering Data 

добавлен материал Structural Steel. Его мы будем использовать как материал, 

из которого состоит труба. Поэтому новых материалов добавлять не нужно. 

Заходим в Static Structural → Model. В дереве проекта открываем 

вкладку Model(A4) →Geometry. Исключаем объем, занимаемый жидкостью. 

Нажимаем правой кнопкой мыши на Fluid, выбираем Suppress Body 

(рисунок 3.6). 
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Рисунок 3.6 – Исключение объема, занимаемого жидкостью. 

В дереве проекта выбираем Mesh. Нажимаем правой кнопкой мыши на 

Mesh →Insert →Method. Выбираем объем, соответствующий стенке. 

Подтверждаем выбор кнопкой Apply. Задаем метод Method → Tetrahedrons, 

Algorithm → Patch Conforming. В поле Sizing → Max Face Size выставляем 

размер в 0.01 m (рисунок 3.7). 

 

Рисунок 3.7 – Конечно-элементная сетка на модели стенки. 
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Устанавливаем следующие граничные условия: жесткая заделка на 

торцевых поверхностях и условие взаимодействия трубы с жидкостью 

(рисунок 3.8). 

 

Рисунок 3.8 – Граничные условия. 

Выбираем левой кнопкой мыши в дереве проекта Static Structural (A5) 

→ Analysis Settings. В Details задаем значения параметров в Step Controls: 

Step End Time – 1.s, Auto Time Stepping – Off, Time Step – 0.1 s (рисунок 3.9). 

 

Рисунок 3.9 – Значения параметров задачи. 

Закончили работу в Static Structural. Закрываем данный модуль. 

Убеждаемся, что напротив Model и Setup стоят зеленые галочки. Если вместо 

галочек нарисована желтая молния, то кликаем правой кнопкой мыши по 

этому разделу и нажимаем Update. Сохраняем проект (рисунок 3.10). 
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Рисунок 3.10 – Модуль Static Structural. 

Переходим к работе с моделью жидкости в модуле Fluid Flow (CFX). 

Заходим в Mesh и исключаем объем, принадлежащий стенке трубы подобно 

пункту 8. 

Задаем вход, выход и условие взаимодействия жидкости с трубой. Для 

этого выбираем торцевую поверхность на входе, щелкаем правой кнопкой 

мыши по полю, где находится модель, и выбираем Create Named Selection. 

Вход называем Inlet (рисунок 3.11).  

 

Рисунок 3.11 – Вход (Inlet). 

То же самое проделываем для двух оставшихся торцевых 

поверхностей. Это будет выход. Назовем их Outlet (рисунок 3.12). 
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Рисунок 3.12 – Выход (Outlet). 

Поверхность взаимодействия жидкости и трубы назовем Inter (рисунок 

3.13). 

 

Рисунок 3.13 – Взаимодействие жидкости и твердого тела (Inter). 

Подобно пункту 9 создаем вычислительную сетку на модели жидкости. 

Model (B3) → Mesh → Insert → Method. Выбираем объем, соответствующий 

жидкости. Подтверждаем выбор кнопкой Apply. Задаем метод Method → Hex 

Dominant. В поле Sizing → Max Face Size выставляем размер в 0.005 m 

(рисунок 3.14). 
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Рисунок 3.14 – Конечно-элементная сетка на модели жидкости. 

Закрываем вкладку Mesh модуля Fluid Flow (CFX). Убеждаемся, что 

напротив Mesh стоит зеленая галочка. Сохраняем проект. Переходим во 

вкладку Setup. В дереве Setup переходим к Flow Analysis 1 → Analysis Type. 

Задаем время: Total Time – 1s, Timesteps – 0.1s, Analysis Type – Transient. 

Принимаем изменения. (Данные действия представлены на рисунке  3.15).  

 

Рисунок 3.15 – Вкладка Analysis Type. 

Так как в нашей модели в качестве жидкости будет использоваться 

обычная вода (она уже добавлена по умолчанию), то данный шаг описан для 
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тех случаев, когда модель жидкости представлена иным материалом. На 

панели инструментов кликаем по значку Material и добавляем в появившемся 

окне название материала (рисунок 3.16). 

 

Рисунок 3.16 – Панель инструментов. 

 

Далее на вкладке Basic Settings выставляем в Option – Pure Substance, и 

в Material Group – User (рисунок 3.17). 

 

Рисунок 3.17 – Параметры материала. 

Переходим на вкладку Material Properties. Задаем плотность Density [kg 

m^-3] и динамическую вязкость Transport Properties → Dynamic Viscosity [Pa 

s]. Принимаем изменения (рисунок 3.18). 

 

Рисунок 3.18 – Параметры материала. 

В дереве проекта выбираем Simulation → Flow Analysis1 → Default 

Domain. Во вкладке Basic Settings задаем материал, который будет 
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использоваться в задаче (в нашем случае это вода): Material – Water, Mesh 

Deformation – Region of Motion Specified (рисунок 3.19). 

 

Рисунок 3.19 – Вкладка Default Domain. 

На следующей вкладке Fluid Models меняем все значения на None 

(рисунок 3.20). 

 

Рисунок 3.20 – Вкладка Fluid Models. 

Зададим граничные условия. Нажимаем правой кнопкой на Default 

Domain → Insert → Boundary. Называем Inlet. Переходим на вкладку 

Boundary Details. В поле Mass And Momentum → Option выбираем ту 

характеристику, которую хотим задать на входе модели. В нашем случае это 
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будет скорость. Выбираем Normal Speed и выставляем значение в 3 [m s^-1] 

(рисунок 3.21). 

 

Рисунок 3.21 – Граничное условие на входе. 

Также, можно добавить характеристику, которая задается функцией, 

нажав на значок, указанный на рисунке 3.22. 

 

Рисунок 3.22 – Добавление функции. 

Задаем аналогичное граничное условие для выхода. Нажимаем правой 

кнопкой на Default Domain → Insert → Boundary. Называем Outlet. 

Переходим на вкладку Boundary Details. В поле Mass And Momentum → 

Option выбираем ту характеристику, которую хотим задать на выходе 

модели. В нашем случае это будет давление. Выбираем Average Static 

Pressure и выставляем значение в 0 [Pa]. Здесь также можно добавить 

характеристику, которая задается функцией (рисунок 3.23). 

 

Рисунок 3.23 – Граничное условие на выходе. 
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Создадим условие контакта FSI (Fluid Solid Interface). Переходим в 

Simulation → Flow Analysis1 → Default Domain → Default Domain Default. Во 

вкладке Basic Settings выставляем в поле Boundary Type – Wall 

(рисунок 3.24). 

 

Рисунок 3.24 – Вкладка Basic Settings. 

Далее переходим во вкладку Boundary Details. В поле Mesh Motion – 

Option выбираем ANSYS MultiField. В поле Mass And Momentum – Option 

выбираем No Slip Wall (условие прилипания частиц жидкости к стенке) 

(рисунок 3.25). 

 

 

Рисунок 3.25 – FSI. 

Зададим начальные условия. На панели инструментов кликаем по 

значку Global Initialization. Проставляем нулевые значения скоростей и 

давления (рисунок 3.26). 
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Рисунок 3.26 – Начальные условия. 

Далее заходим в Simulations → Flow Analysis 1 → Solver → Solver 

Control. На вкладке External Coupling выбираем последовательность решения 

Solve ANSYS Fields – After CFX Fields (рисунок 3.27). 

 

Рисунок 3.27 – Вкладка External Coupling. 

Переходим в Simulations → Flow Analysis 1 → Solver → Output Control. 

На вкладке Trn Results создаем новый файл для записи результатов. 

Устанавливаем частоту записи результатов в поле Output Frequency – Option 

– Every Timestep (рисунок 3.28). 



39 

 

 

Рисунок 3.28 – Вкладка Trn Results. 

Выходим из модуля Fluid Flow (CFX). Убеждаемся, что напротив 

Geometry, Mesh и Setup стоят зеленые галочки. Если вместо галочек 

нарисована желтая молния, то кликаем правой кнопкой мыши по этому 

разделу и нажимаем Update. Нажимаем на Solution – Refresh. Сохраняем 

проект. 

Запускаем решение. Заходим в Solution. В появившейся табличке 

меняем в поле Parallel Environment – Run Mode – IBM MPI Local Parallel 

устанавливаем на значение 4 (в зависимости от количества поток вашего 

ПК). Нажимаем Start Run (рисунок 3.29). Если задача посчиталась верно, то в 

конце решения появится табличка с надписью Solution is done!. 
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Рисунок 3.29 – Подготовка к запуску. 

Займемся просмотром результатов решенной задачи. В модуле Fluid 

Flow (CFX) открываем вкладку Results. Отобразим линии тока жидкости в 

модели, перемещения и напряжения в стенке модели. 

Отобразим линии тока жидкости. На панели инструментов выбираем 

Streamline (рисунок 3.30). 

 

Рисунок 3.30 – Панель инструментов. 

Далее в появившемся окне выставляем настройки, как показано на 

рисунке 3.31 и нажимаем применить. В итоге получим картину, 

представленную на рисунке 3.32. 
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Рисунок 3.31 – Окно настройки Streamline. 

 

Рисунок 3.32 – Линии тока жидкости. 

Покажем перемещения в стенке модели. В Cases → ANSYS at 1s → 

Default Domain → Default Boundary. Выставляем все, как показано на 

рисунке  3.33. Также, сделаем логарифмическую шкалу, для более удобного 

отображения результатов. Получим картину, представленную на 

рисунке 3.34. 
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Рисунок 3.33 – Окно настройки Default Boundary. 

 

Рисунок 3.34 – Перемещения стенки модели. 

Покажем напряжения модели стенки. На панели инструментов 

выбираем Contour. В настройке выставляем все, как показано на 

рисунке 3.35. В итоге получим картину, представленную на рисунке 3.36. 
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Рисунок 3.35 – Окно настройки Contour. 

 

Рисунок 3.36 – Напряжения стенки модели. 
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4 Расчёт плоской рамы, сравнение элементов типа Beam и 

Link 

4.1 Элемент типа Beam 

Рассмотрим задачу о нагружении плоской рамы с использованием 

элемента Beam. 

Сначала необходимо выбрать тип задачи в главном меню (Main Menu) 

в пункте «Preferences» (рисунок 4.1.1) 

 

Рисунок 4.1.1 – Главное меню. 

В появившемся окне выбираем тип «Structural» (рисунок 4.1.2). 

 

Рисунок 4.1.2 – Выбор типа задачи. 

Добавим элемент в меню Preprocessor → Element Type → 

Add/Edit/Delete (рисунок 4.1.3). 
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Рисунок 4.1.3 –Добавление типа элемента. 

Выберем тип элемента Beam 188 (рисунок 4.1.4). 

 

Рисунок 4.1.4 – Выбор элемента Beam 188. 

Зададим свойства материала в меню Preprocessor → Material Props → 

Material Models, как показано на рисунке 4.1.5 (модуль Юнга, коэффициент 

Пуассона). 

 

Рисунок 4.1.5 – Задание свойств материала. 
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Зададим геометрические размеры сечения в меню Preprocessor →Sections → 

Beam → Common Sections (рисунок 4.1.6). 

 

Рисунок 4.1.6 – Задание размеров поперечного сечения. 

Перейдем к построению геометрической модели. Задаем точки в 

активной системе координат в меню Preprocessor → Modeling → Create 

Keypoints→ In Active CS (рисунок 4.1.7). 

 

Рисунок 4.1.7 – Задание точек. 

Соединим точки линиями в меню Preprocessor → Modeling → Create 

Lines → Straight Line (рисунок 4.1.8). 
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Рисунок 4.1.8 – Создание линий. 

Задаем размеры сетки в меню Preprocessor → Meshing → Mesh Tool → 

Size Control: Global → Set. В окне «Global Element Size» необходимо задать 

либо размер элемента «Element edge length», либо количество делений «No. 

of element divisions» (рисунок 4.1.9). 

 

Рисунок 4.1.9 –Задание размера сетки. 

Построим сетку, нажав на клавишу Mesh и выделив элементы 

(рисунок 4.1.10). 
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Рисунок 4.1.10 – Выделение элементов для построения сетки. 

Переходим к заданию граничных условий. Выберем область (точку), в 

которой необходимо задать условие в меню Preprocessor →Loads → Define 

Loads → Apply → Structural →Force/Moment → On Keypoints или, что 

дублирует предыдущий путь, Solution → Define Loads → Apply → Structural 

Displacement → On Keypoints (рисунок 4.1.11). 

 

Рисунок 4.1.11 – Выбор области задания граничного условия. 

Зададим граничные условия в окне, показанном на рисунке 4.1.12 

(жёсткая заделка, шарнир). 
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Рисунок 4.1.12 – Задание граничных условий. 

После задания граничных условий модель должна вуглядеть так, как на 

рисунке 4.1.13. 

 

Рисунок 4.1.13 – Рама с заданными граничными условиями. 

Далее приложим нагрузки в точках или узлах в меню Preprocessor →Loads → 

Define Loads → Apply → Structural →Force/Moment → On Keypoints или 

Solution → Define Loads → Apply → Structural Displacement → On Keypoints 

(рисунок 4.1.14). 

 

 

Рисунок 4.1.14 – Приложение нагрузок. 
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После приложения нагрузок модель должна вуглядеть так, как на 

рисунке 4.1.15. 

 

Рисунок 4.1.15 – Рама с заданными граничными условиями и нагрузками. 

Запустим задачу на расчет в Solution→Solve→CurrentLS 

(рисунок 4.1.16). 

 

Рисунок 4.1.16 – Решение задачи. 

После того, как появится сообщение о завершении решения, перейдем 

к отображению результатов. Отобразить результаты можно в меню General 

Postproc → Plot Results → Contour Plot → Nodal Solution (рисунок 4.1.17). 
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Рисунок 4.1.17 – Анализ результатов. 

Выберем результаты, которые нужно отобразить: в нашем случае это 

суммарные перемещения (рисунок 4.1.18). 

 

Рисунок 4.1.18 – Выбор необходимых результатов. 

В итоге в рабочем окне должна быть отрисована деформированная 

геометрия рамы с изображенной цветовой шкалой, соответствующей 

значениям перемещений. 
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Рисунок 4.1.19 – Отображение перемещений. 

4.2 Элемент типа Link 

При решении задачи о нагружении плоской рамы с использованием 

элемента типа Link 180 многие шаги из предыдущей главы будут 

повторяться, поэтому останавливаться на них подробно не будем. После 

подготовительных шагов, связанных с выбором типа задачи, выберем тип 

элемента Link 180 (рисунок 4.2.1). 

 

Рисунок 4.2.1 – Выбор типа элемента Link180. 

Зададим площадь поперечного сечения в меню Preprocessor→ Real 

Constants → Add/Edit/Delete в графе Cross-sectional area (рисунок 4.2.2). 
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Рисунок 4.2.2 – Задание площади поперечного сечения. 

Аналогично предыдущему случаю зададим параметры поперечного 

сечения, после чего перейдем к построению геометрической модели. Зададим 

узлы в меню Preprocessor → Modeling → Create→ Nodes→ In Active CS 

(4.2.3). 

 

Рисунок 4.2.3 – Задание узлов. 

Соединим построенные узлы в меню Preprocessor → Modeling → Create 

→ Elements → Auto Numbered → Thru Nodes. 

Далее аналогично предыдущему случаю зададим граничные условия и 

запустим задачу на расчет, после чего в результате получим перемещения, 

изображенные на рисунке 4.2.4. 
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Рисунок 4.2.4 – Отображение модуля вектора перемещений. 

Как видно из рисунков 4.1.19 и 4.2.4, максимальные значения 

перемещений совпадают для элементов Beam 188 и Link 180. Таким образом, 

при моделировании растяжения (сжатия) стержней можно использовать 

любой из данных элементов. Однако при моделировании изгибных 

деформаций элемент типа Link 180 не подойдет, так как этот элемент 

работает только на сжатие (растяжение). 
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5 Параболический и прямоугольный профиль скорости на 

входе в сосуд: сравнительный анализ методом конечных 

элементов 

При решении задач о течении крови в сосудах требуется ставить 

граничные условия на входе в сосуд. Как правило, исследователи задают 

объемный поток или скорость потока крови. По сей день не угасают споры о 

том, какой профиль скорости необходимо задавать: параболический или 

прямоугольный.  

В данном разделе попробуем разобраться, насколько важно учитывать 

и ставить параболический профиль скорости на входе в сосуд при 

выполнении численных расчетов методом конечных элементов. 

Сначала рассмотрим, какую форму будет иметь профиль скорости в 

течение 1 секунды на входе в сосуд диаметром 5 мм в плоской постановке. 

Предположим, что скорость меняется во времени по синусоидальному 

закону. Будем рассматривать прямоугольный профиль высотой 0.25 см/с и 

аналогичный по объемному расходу параболический, задаваемый 

следующим уравнением 

   .005.060000  yyy  

Параметры уравнения, приведенного выше, были подобраны исходя из 

требования равенства объемных кровотоков для обоих профилей. Объемный 

кровоток в сечении – это интеграл от нормальной компоненты скорости 

крови по площади сечения. 

На одном графике эти две кривые будут выглядеть следующим образом 

(рисунок 5.1). 
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Рисунок 5.1 – Прямоугольный и парболический профили скорости  

на входе плоской модели сосуда. 

Проиллюстрируем входные данные для сосуда, для чего построим 

пространственные поверхности (рисунок 5.2, 5.3). 
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Рисунок 5.2 – Поверхность скорости на входе для прямоугольного профиля скорости 

(по горизонтальным осям отложены время и координата). 
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Рисунок 5.3 – Поверхность скорости на входе для параболического профиля скорости  

(по горизонтальным осям отложены время и координата). 

Проведем численный расчет течения крови в плоской прямоугольной 

области высотой 5 мм и длиной 5 см с представленными выше граничными 

условиями на входе для скорости потока крови. На боковых поверхностях 

будем задавать условия прилипания, на выходе нулевое давление. Кровь – 

вязкая несжимаемая однородная ньютоновская жидкость. 

Результаты расчетов показали, что на расстоянии нескольких 

диаметров от начала канала профили скорости становятся не зависящими от 

граничных условий на входе. На рисунке 5.4 представлены профили 

скорости потока крови на выходе из канала при расчете с прямоугольным и 

параболическим профилем скорости на входе в канал. Видно, что и форма, и 

числовые значения практически неотличимы. Более того, если проводить 

расчет сосудов с бифуркациями, то разница будет еще менее заметной. 
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Рисунок 5.4 – Профили скорости потока крови на выходе из канала  

при расчете с прямоугольным и параболическим профилем скорости  

на входе в канал. 

Рисунок 5.5 показывает поле скоростей для обоих профилей скорости 

крови на входе в плоский канал. 

 

Рисунок 5.5 – Поле скоростей в каналах  

в зависимости от типа профиля скорости на входе. 

В данном примере расчеты проводились в системе конечно-

элементного анализа ANSYS Mechanical APDL. Использовалась  регулярная 

четырехугольная вычислительная сетка, состоящая из плоских 

четырехугольных элементов Flotran141. 

Задание скорости потока крови на входе в виде функции в ANSYS 

APDL осуществляется в меню Parameters->Functions, что проиллюстрировано 

на рисунке 5.6.  
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Рисунок 5.6 – Создание функции в ANSYS APDL. 

Затем созданная функция сохраняется в файл и читается, и 

записывается в таблицу (рисунок5.7), которую можно использовать при 

постановке граничных условий. 

 

Рисунок 5.7 – Запись функции в виде таблицы. 

Можно сделать вывод, что при численных расчетах поведения сосудов 

человека необязательно усложнять профиль задаваемой на входе сосудов 

скорости крови. Достаточно знать линейную скорость потока и ее изменение 

в течение сердечного цикла. 
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6 Нагружение балки в два шага 

Рассмотрим задачу о колебаниях консольной балки, вызванных 

временно действующей нагрузкой. В данном примере рассматривается 

плоская модель балки. Одни конец балки жестко закреплен, на втором конце 

действует сосредоточенная изгибающая сила. В примере используется 

возможность ANSYS прикладывать нагрузки в несколько шагов (loadstep).  

На первом этапе нужно построить выбрать тип анализа 

Preprocessor->Preferences->Structural. 

Далее из библиотеки элементов требуется выбрать элемент 

(четырехугольный четырехузловой линейный плоский элемент) 

Preprocessor->Preferences->Element type->Add->Quad 4 node 42. 

На следующем шаге задаем свойства материала балки (однородный 

изотропный и линейно-упругий)  

Preprocessor->Preferences->Material prop->Material models->Structural-

>Linear->Elastic->Isotropic (модуль Юнга 2Е11 Н/м
2
, коэффициент Пуассона 

0.33), а также задать плотность материала (7800 кг/м
3
) 

Preprocessor->Preferences->Material prop->Material models->Structural-

>Density. 

Геометрическая модель балки строится следующим образом 

Preprocessor->Modeling->Create->Ares->Rectangle->By 2 corners. 

В полях height, width ставим 10 м и 1 м соответственно. 

Получаем следующий прямоугольник, показанный на рисунке 6.1. 

 

Рисунок 6.1 – Геометрическая модель плоской балки. 
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На следующем шаге нужно построить вычислительную сетку. 

Геометрия модели простая, поверхность регулярная. Поэтому в данном 

случае мы легко можем создать регулярную четырехугольную сетку 

(рисунок 6.2).  

Preprocessor->Meshing->Mesh tool.  

В size controls->global задаем размер элемента 0.1. Далее: Preprocessor-

>Meshing->Mesh tool->Quad->Mapped->Mesh. 

 

Рисунок 6.2 – Четырехугольная регулярная сетка. 

Далее необходимо настроить решатель, определить тип анализа и 

поставить граничные условия для первого шага нагружения (рисунок 6.3). 

Solution->Analysis type->Sol’n controls 

 

Рисунок 6.3 – Окно настроек решателя Solution Controls. 
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Мы выбираем нестационарный анализ, принимаем гипотезу малых 

деформаций, конечное время на шаге нагружения – 1 с. Задается 10 подшагов 

нагрузки и осуществляет запись всех подшагов в файл результатов.  

Постановка граничных условий производится в следующем меню  

Solution->Define Loads->Apply->Structural->Displacements->On lines-

>All DOF. 

Здесь мы жестко закрепляем левый конец балки, то есть задаем 

нулевые перемещения по левой вертикальной линии. 

На правом конце балки прикладываем сосредоточенную силу 100 кН 

Solution->Define Loads->Apply->Structural->Force/Moment->On 

Keypoints->FX. Покажем поставленные граничные условия на рисунке 6.4.  

 

Рисунок 6.4 – Граничные условия плоской балки. 

Далее мы запускаем первый шаг нагружения на расчет:  

Solution->Solve->Current LS->Ok. 

После появления на экране надписи «Solution is done», мы должны 

поменять граничные условия и настройки решателя, не выходя из меню 

Solution. Нужно убрать силу на консольном конце балки (Solution-

>Define Loads->Delete->Structural->Force/Moment->On Keypoints) и задать 

конечное время на втором шаге нагружения – 2 с. 

После этого мы снова выполняем расчет Solution->Solve->Current LS-

>Ok. Результаты расчета второго шага нагружения добавляются к 

результатам расчета первого шага нагружения. 
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Теперь можно проанализировать и визуализировать результаты 

расчетов. Сначала посмотрим, какие подшаги были сохранены (рисунок 6.5). 

General Postproc->Results summary. 

 

Рисунок 6.5 – Список сохраненных подшагов. 

Мы видим, что программа сохранила 20 подшагов, как и 

предполагалось. Выберем подшаг из первой секунды расчета (первого шага 

нагружения): General Postproc->Read results->By pick-> 0.9 c. 

Отобразим перемещения балки в этот момент времени. 

General Postproc->Plot results->Сontour plot->Nodal solution->DOF 

solution->Displacement vector sum (рисунок 6.6). 

 

Рисунок 6.6 – Перемещения балки на первом шаге нагружения. 
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Выберем подшаг из второй секунды расчета (второго шага 

нагружения). 

General Postproc->Read results->By pick-> 1.1 c. 

Далее щелкнем правой кнопкой мыши по рабочей области и в 

контекстном меню выберем Replot (рисунок 6.7). 

 

Рисунок 6.7 – Перемещения балки на втором шаге нагружения. 

Мы видим, что после снятия нагрузки балка колеблется. Другими 

словами, свободный конец балки поднимается и опускается, что 

продемонстрировано на рисунках 6.6, 6.7. Можно создать анимацию с 

движением балки: Plot Ctrls->Animate->Over results (over time). 
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7 Команды для активирования режима FSI 

ANSYS Mechanical APDL (ранее интерфейс назывался Prep7) позволяет 

решать связанные упруго-гидродинамические задачи. Такие краевые задачи 

описывают движение крови в сосудах человека: кровь действует на стенку 

силами вязкости и давлением, стенка изгибается и деформируется, 

вследствие чего изменяется область течения крови. Для решения связанных 

задач используется модуль Flotran (конечные элементы Fluid141, Fluid142). 

Решение связанных задач в ANSYS Mechanical APDL можно 

производить двумя способами: с помощью MFX Solver или при помощи 

ввода команд. Рассмотрим команды, которые необходимо ввести для 

активации режима FSI (fluid-structure interaction). 

fsan,on // активирование FSI 

fsor,fluid // выбор очередности решения 

fstr,fluid,tran // выбор типа анализа для fluid (tran или stat) 

fstr,solid,tran // выбор типа анализа для solid (tran или stat) 

fsin,nonc // выбор типа интерполяции между полями (nonc или cons) 

fsti,1 // установка времени интегрирования 

fsdt,.005 // установка шага интегрирования 

fsit,10 // установка количества итераций 

fsco,all,.01 // установка критерия для сходимости 

fsre,all,0.8 // установка параметра релаксации 

Данные команды сохранились в ANSYS со времен версий 8.0 и ниже, 

при этом современные версии ANSYS выдают ошибку при вводе команд, тем 

не менее, команды работают.  
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Заключение 

В пособии приведены некоторые примеры решения типовых задач 

механики и гидродинамики с помощью системы конечно-элементного 

моделирования ANSYS.  

Рассмотренные примеры позволяют сравнить некоторые подходы к 

решению типовых задач, получить базовые знания по постановке задач 

механики и гидроупругости в среде ANSYS, а также по визуализации 

результатов и их интерпретации. 

Конечно, в пособии не охвачены многие функции и опции, доступные в 

модулях ANSYS. Но это и не было целью. Основная цель состояла в том, 

чтобы научить базовым функциям при работе с геометрией, 

вычислительными сетками и функциями постановки и решения задач на 

конкретных примерах задач производственной и научной деятельности.  

Считаем, что пособие будет полезно начинающим инженерам, 

студентам, магистрам, бакалаврам и аспирантам, занимающимся численным 

моделированием краевых задач в системе ANSYS. 
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